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Introduction
This Demo Guide is a tool to help to promote OpenOffice.org 2.0 new features to various
audiences.
To cover most presentation opportunities the guide itself as well as the demo documents
are all in (British) English. Still none of the documents contain elements that are offensive
to any culture or religion.
This Demo Guide is not a classic slide-based presentation! It is made to hold “live”
presentations based on real-life scenarios with real-life document samples.
One of its major advantages is the universal area of operation. It covers all major new
features in OpenOffice.org 2.0. The whole guide is set up in a modular way, meaning that
one can use the guide as whole as well as only part s of it for a specific audience.
The whole presentation time of this guide is approx. 15 to 20 minutes , depending on the
presenters speed and level of detail.
Whenever you feel that some new feature is missing or not extensively enough covered I
very much appreciate feedback, suggestions, updates and new demo documents.
You can contact me and send your input to falko@sun.com.
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How-To
This chapter will deal with all aspects on how this Demo Guide can help to set up and held
a presentation for OpenOffice.org.
It will also explain how to use the two-columned “What to do” - “What to say” structure
you will find in the following chapters.

First of all
Some parts of the demos require additional documents and data. These documents and
files are a pre-condition for the whole presentation.

Preconditions
• JDS2 must be installed (standard installation)
• All demo files must be downloaded and accessible (see First of all)
• MySQL must be installed (see section “How to install mySQL support)
• The newest build of OpenOffice.org  2.0 must be installed

Preparing a Presentation/Demo
To set up a functional work environment follow these steps:
• Install OpenOffice.org 2.0
• Install mySQL support:

-1- Open a terminal and become root on your system.
-2- Make sure that you JDS 2 is connected to the internet and that proxy settings are

are set up properly.
To check this type  export | grep proxy
If you don't get something like 
  declare -x ftp_proxy="my-proxy.at.com:8080"
  declare -x http_proxy="my-proxy.at.com:8080"
type in the following:
  export ftp_proxy="my-proxy.at.com:8080"
  export http_proxy="my-proxy.at.com:8080"

-3- Install the necessary rpm packages.
Since there are some dependencies simply installing the packages becomes an
awful task we use yast for this.
(a) Start yast as root and go to Software – Change source of installation
(b) Press ALT+a to add a new source and choose FTP
(c) Insert ftp.gwdg.de in Server name field
(d) Insert pub/linux/suse/ftp.suse.com/suse/i386/8.1 in Directory

on server field.
(e) Confirm with OK (and wait for a while, can be actually 2 or 3 minutes!)
(f) Now promote the new  entry to top by pressing ALT+u and disable all other

entries with  ALT-L
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(g) Finally press ALT+F to finish.
(h) Now change into Software – Install or remove software
(i) Use ALT+S to search for mysql
(j) Select the following packages for installation with +:
• mysql-shared
• mysql
• mysql-client

(k) Use ALT+S again to search for ODBC
(l) Select the following packages for installation with +:
• MyODBC-unixODBC
• unixODBC

(m)Finally confirm installation of made selection with OK
(n) Exit yast
(o) Finally we need a frontend for mySQL. Do so by 

rpm -ivh http://packman.iu-
bremen.de/suse/8.1/i586/mysqlcc-0.8.7-0.i586.rpm

-4- Now we start the mySQL server by typing rcmysql start
-5- Finally we make this setting permanent with 

chkconfig -add /etc/init.d/mysql
This way mySQL server will always start up whenever JDS2 is booted.

-6- Leave the root-shell.
-7- As your own account create a file .odbc.ini with

vi ~/.odbc.ini
Insert the following into this file:
[ODBC Data Sources]
mysql = MySQL test

[DemoDB]
Driver    = /usr/lib/unixODBC/libmyodbc.so
Database  = test
SERVER    = localhost
UID       = root
PORT      = 3306
TRACE     = OFF
TRACEFILE = sdtout

-8- Start  mysqlcc
-9- Add a new database via  File – New
-10-Type in DemoDB in  Name field, root in User Name. Leave all other fields blank

resp. as they are.
-11-Add
-12-In mysqlcc goto  Action – Connect
-13-Close mysqlcc
-14-Copy the following files to /var/lib/mysql/test (you must be root for this):

• Products.MYD
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• Products.MYI
• Products.frm

-15-Ready.

Using this Demo Guide
Once everything is installed and runs fine you can start setting up you actual Demo Time
Table.
This is when the two-columned “What to do” - “What to say” chapter for each application
come in action.
Basically these two-columned “What to do” - “What to say” are layout like this:

What to do What to say
Open “File – Open” dialogue and change to
home directory by pressing the “home”
button on top  right.

“I will now open a new document. With the
home-button I can easily navigate right to
my home directory”

... ...

What to do
This column  gives detailed instructions on how to navigate through the current demo part.
It will partly also contain screen shots to illustrate the steps to follow.

What to say
This column correspondents with the “What to do” column and will basically dub the action
with wording.
The text in this column can be used word-by-word but it is not really meant this way. It
should rather inspire the person running the demo what to say. The text should give
enough information to alter the text to adjust it perfect to the audience.
Again, like in “What to do” all different behaviours are marked by a prefix in capital letters.

Symbols (third column)
From time to time you will find one or more symbols  in the register. 
Symbols are there to draw your attention to special features or extraordinary items. These
could be general hints as well as high-level features.
Please refer to the legend below for a complete, documented list of all symbols.

List and legend of symbols

Symbol Legend

Attention - This symbol appears wherever the Demo Guide draws your attention
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Symbol Legend
Question  - This section might lead to questions from the audience and might
need more in-depth information.
Tip – This part is an eye-catcher for the audience. You can show special, high-
level or eye-candy features of OpenOffice.org.
Magic – A bit like the tip but less “reality-related”. A feature that has a
“WOW”-effect but has  only little effect on every day's work
Play it loud– This symbols states that the feature next to it is a feature that MS
Office does not have it or at least where OpenOffice.org is superior to MS Office.
Time – This example is very time-consuming to show. This can be due to high-
complexity or necessary work on the document during presentation
Online – for this part of the presentation you need to have a working Internet
connection at hand. Without it this feature cannot presented.
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Story Line
Since this is a 10-15 minutes presentation there is no real story line sensible.
Basically the story line is to tell the audience our most rewarded new features.
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New/enhanced UI
Introduction words
OpenOffice.org has greatly improved and renewed its look and feel.
Three major UI parts have been addressed:
• Toolbars
• Menus
• System integration
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What to do What to say
Part 1: Give an overview

Open OpenOffice.org 2.0 Writer window. This is a preview of our upcoming next
version of OpenOffice.org, version 8.
I will give you an overview about some of
our major new or enhanced features.
Most of those changes are based on
feedback from customers and community.
We are currently re-working the complete
UI of OpenOffice.org to ease migration for
former MS Office users as well as giving
OpenOffice.org a more mosdern and sleak
look in general.
Therefore we addressed three major UI
parts:
• Toolbars
• Menus
• System integration

Part 2: New Toolbars

Detach a toolbar, resize it and re-attach it
again.

Click on the table icon. Make sure that you
click on the little arrow right from the icon.
Select a range of 5x4 (or so) cells and
create a table
Release mouse button and point to new
format - table float.

Lets start with the toolbars:
All toolbars are now move-able and
detachable. The user is free to align his
toolbars the way he needs it for his
everyday work.
Also the toolbars become for context-
sensitive, the user will always be presented
by all necessary tools for the current task.
Just let insert a table from within the new
table button.

Now that the cursor stands within the table
the context-sensitive table toolbar pops up.

Part 3: Menus
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What to do What to say
Open OpenOffice.org 2.0
Insert some text in the empty document and
open the “Format” menu. Travel through the
menu and show new, context sensitive
entires.

Insert now a table and show the content of
the new “Table” menu.
Stop at the entry “Formula”.

The next issue are menus:
All menus have been completely re-worked.
Again to make transition from MS Office
easier but also to stream-line and shorten
the old menus of OpenOffice.org.
Main focus was to help user to find features
quicker and easier by having more comact
first tier menu structures as well helping
users coming from Word & Co. to adjust
themselves to OpenOffice.org in a short
period of time.
As you can see Writer even has an entry
that Word does not have:
Formula, it allows you to calculate within
tables!
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What to do What to say
Part 4: System Integration

Right-click on document canvas and
choose “Character”. Travel around this
dialogue showing native widgets, such as
tabs, drop-down list boxes, scrollbars and
buttons.

(Menu integration does NOT work with this
version)

And last but not least system integration:
Even OpenOffice.org has a big advantage
over its competitors – being nearly platform
independent – a drawback of this
advantage always was that UI controls such
as buttons, sliders etc. looked all the same
on all platforms, making OpenOffice.org
always looking slightly alien.
This now has changed: OpenOffice.org
uses the widgets of the OS and Window
Manager (Theme) it runs on. As you can
see, OpenOffice.org running on JDS uses
the GTK JDS theme. Now OpenOffice.org
looks and feels exactly like every other
native application and integrates seamless
into the working environment.
System integration also means that
OpenOffice.org now follows also standard
guidelines when integrating into the
program menus on all OS it runs on.
Example: On windows OpenOffice.org now
integrates itself flat straight into the
programs folder with it module names, like
Writer, Calc, Impress etc., instead using a
sub-menu with document naming, like Text
Document etc.

Close this version and delete
~/.OpenOffice.org8 directory
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Impress – TriPane View and MS Office Import
Introduction words
To ease migration the UI of our presentation module Impress has completely revamped.
Impress now uses a familiar tripane view that allows the user get an immediate overview
on his presentation.
Also interoperability with MS Office has been greatly enhanced by natively supporting
AutoShapes.
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What to do What to say
Mandatory, please read:

If this version crashes never close the error report agent with the close button. Always
use the “Do not send” button. Otherwise you might have to kill the application by using
kill -9 command on about half a dozen threads!

Part 1: TriPane View

Start Tripane-View enabled OpenOffice.org
version with MS PowerPoint presentation
as a parameter (do NOT try to open this
document from within Impress, it will
crash!):
/opt/OpenOffice.org8/programs/simpress /
path/to/presentation/dotNetOverview.ppt
Close all open floaters and enabled tripane
view by “View – MultiPane GUI – Show
Slide Panel/Show Tool Panel”.
Both panels appear in size zero so you
need to resize them with the mouse by
dragging the panel edges.

Click slowly on single slide in the left
preview pane and let them load in the main
window.
Change to the right pane click on a random
Master Page preview (attention: takes quite
long to load!).
Return to the original state by clicking on
the original master in “Recently User
Masterpages”
Go back to the left pane and drag and drop
slides to re-sort them.

Use the tab pages to travel through the
main window view in exact this order:
Drawing View -> Outline View -> Notes
View -> Handout View (Slide View crashes!)

To ease migration the UI of our
presentation module Impress has
completely revamped.

Impress now uses a familiar tripane view
that allows the user get an immediate
overview on his presentation.

It also eases navigation and editing.
Thanks to the left preview pane you can
select the slide you want for editing in the
main window by a quick and simple click
while in the right pane you can change your
presentations overall look and feel by
selecting another template, layout or master
page.

Moreover the left pane can act as a slide
sorter with a slide transition preview giving
the full control on your presentation in one
window.
Of course the “old” views are preserved so
the user can change in between drawing,
outline, notes, handout and slides view
within the main frame.

Part 2: Interoperability

Demo Guide Page 13 Impress – TriPane View and MS Office
Import



OpenOffice.org 2.0
Sponsored by Sun Microsystems, Inc

What to do What to say

Again use the left pane to travel through the
presentation in exact slide order (1, 2, 3,
etc). When you reach slide 8 (“.NET
foundation services”) ...

You might ask yourself why this opened
presentation is about dot net?
Well it is actually a presentation created by
Microsoft with PowerPoint for their very own
customers.
Browsing through the presentation shows
that Impress 8 imports a MS PowerPoint
presentation basically 1:1.

Part 3: AutoShape Support

...change to the main window and select
one yellow arrow.

 
Resize the arrow so your audience can
clearly see it.
Grab the yellow handle/dot with your mouse
a change the shape of the arrow by moving
the handler.

Another new feature in Impress 8 is the
integration of Autoshapes. Impress does
not only imports MS AutoShapes in right
shape, size and position but also its feature
such as the shape handler.
Lets just select an arrow on this slide,
resize it for better visibility.
Now you can see the yellow dot – this is the
shape handler that allows me to adjust the
shape of the object to my needs.
Of course these objects will not only be
available via import of MS documents but
will also be integrated into OpenOffice.org
for all applications and usage.
The UI for AutoShapes is in development.

Close the application.
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New Database
Introduction words
Another issue we address with 8 is the database.
In former versions we were asked very often by customers about the visibility of our
database – or better: the non-visibility.
Most users plain couldn't get access to our database module.
This has been completely reworked.
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What to do What to say
Part 1: New Database Format

Start OpenOffice.org 2.0.

Go to “File – New – Database”. You are
now requested to save it, do so with a
random name.

Another issue we address with 8 is the
database.
In former versions we were asked very
often by customers about the visibility of our
database – or better: the non-visibility.
Most users plain couldn't get access to our
database module.
This has completely reworked. You can
now easily access, integrate or create
database by “File – New – Database”.
Of course we do support all important
database types and connections, such as
mySQL, Oracle, ODBC and JDBC.

Walk through the wizard, choose “MySQL
(ODBC)” from database type. 
Choose a database via browse button and
type in username (“demo”) and activate
“Password required”. 
Goto “Test connection”, type in the
password (“demo”).
Once the connection has been established
successfully confirm with OK and the
Cancel the wizard.

I just created a new database and will now
connect to a mySQL database via ODBC.
The wizard asks me for all necessary
setting that are needed to successfully get
access to the database. 

Part 2: Database UI
Open the prepared database
“DemoDb.odb” by “File – Open”
Click on “Tables” in the left panel and enter
the password “demo”.
Wait a second and point to the table
preview in the lower right frame.
Then click on “Forms” in the left panel and
double-click on the entry “Product form” in
the lower right frame.
After a few seconds the forms will appear,
as preview as well as real-life document.
Travel through the real-life version of the
form, close it. 

To show you some capabilities of our
database let me open an already database.
You might note that OpenOffice.org now
has its own database file format. To be
exact, it is basically a container that holds
the connection information, reports, forms
etc.
If you have not only textual data but also
binary data in you database – such as
images – our reports can show them.
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XForms
Introduction words
While talking about forms:
Another major now feature in OpenOfficce 2.0 are Xforms!
What are Xforms?
Basically it is an extension of the existing XML format that allows to add forms functionality
right into XML code. 
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What to do What to say
Part 1: XForms

Open OpenOffice.org 2.0. Best to do so is
to load it like:
/opt/OpenOffice.org8/programs/swriter /
path/to/ubl2.sxw
This way the Xforms is automatically loaded
with Office.

Enter a value in a random “Quantity” field.

Move the cursor down to the “Rebate
Amount”, than go into the quantity cell in
line 2 (Xerox Paper-case) and change the
value to 1.
Now go back to the “Rebate Amount” field.

While talking about forms:
Another major now feature in
OpenOffice.org are Xforms!
What are Xforms?
Basically it is an extension of the existing
XML format that allows to add forms
functionality right into XML code. 
I just opened a simple Writer document.
This Writer document was enhanced with
Xforms.
Let me show you how:
You can see this document is an invoice.
Now if I enter a value in this cell the table
starts to calculate and change all affected
values accordingly.
Have a look at the “Rebate Amount”. If I get
below a certain total amount the rebate
amount jumps to zero.

In other words: This Xform uses
dependencies like if your total is below
value X there will be no rebate.
Since Xforms are open standard this
invoice could also be used to get and send
its information about prices, part numbers
and available quantities from/to a database.

Part 1: Xforms Controls
Open the “Controls_demo.oot” document. Xform can of course look also like classic

forms with dependencies and everything
else you are used from proprietary formats.
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Scripting Framework
Introduction words
An Office is not an Office if it has no macro support. Apart from the already well-known
OpenOffice.org Basic OpenOffice.org now support also BeanShell and JavaScript.
This way basically all developers capable of Java can use their skills to program
OpenOffice.org.

Demo Guide Page 19 Scripting Framework



OpenOffice.org 2.0
Sponsored by Sun Microsystems, Inc

What to do What to say
Part 1: Execute a Macro (-> BeanShell)

Open OpenOffice.org 2.0 and open the
document “BeanShell_Demo.oot”.
Confirm macro execution with “Run”.

Press the button “Push Me!” button and
wait for Java Swing dialogue starting up. 

Type in some random values and change to
Pie chart type. 
Confirm your selection and press OK

An Office is not an Office if it has no macro
support. Apart from the already well-known
OpenOffice.org Basic OpenOffice.org now
support also BeanShell and JavaScript.
This way basically all developers capable of
Java can use their skills to program
OpenOffice.org.
Let me show a simple example:
If I press the “Push Me!”button a dialogue in
Java Swing comes up asking me for some
Chart parameters.
Let's type in some values and confirm.

Now a new spreadsheet with just the data I
submitted is created including a Chart type
that I specified in the Java-Swing dialogue.
Now you can see, we can actually control
our Office not only with our own
OpenOffice.org Basic but also with other
scripting languages, such as BeanShell etc.
Now lets have a look to the macro's source
code:

Part 2: Alternative IDEs (Debug Window)
In the new created spreadsheet go into
“Tools – Macros – Organise Macros -
Beans Shell”.
Doubleclick on “beanshell_text.oot” then
double-click on the opened “Library1” and
again on the opened “Macro1.bsh”
Now press “Edit” button and a “Bean Shell
Debug” window will open. 

A BeanShell debugging window open,
showing that this macro was written in in
BeanShell/Java. Furthermore we waived to
set up our own IDE for those programming
languages in favour of integration of native
tools. We consider that developers are
more familiar with those tools as well as
these tools are most likely more
suited/specialised for their task than a
generic IDE could ever be.
BTW, this script is taken straight from our
sample collection from our SDK. So its
quite easy for you to recreate this example
at your own desk.

Close the “Bean Shell Debug” window,
close OpenOffice.org 
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